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Message from the Chair
Now that the leaves are falling, the geese have flown and
the days are growing cold, perhaps it’s a good time to take
a look back at some of this autumn’s Melta highlights.
First on the list must be Melta Day, which took place
on 21 September. The event featured four workshops by
Melta members on topics ranging from student-centered
activities to voice training to ideas for teaching business
English to technology tips for the classroom. I’d like to
thank all the presenters – Birgitta Berger, Dana Jelinkova,
Nik Granchev, Mike Saunders and Frances Lucey — as
well as the organizers, the cooks, the bakers and everyone
else who helped make the day a great success. Detailed
reports on each of the workshops are included in this issue
of Melta News.
Always innovative, the German tax office has initiated a
new reregistration process for public-service associations.
No longer is it sufficient to submit the necessary — and
extensive — documentation in paper form; online registration in a somewhat complicated electronic format is
now mandatory as well. However, we figured it all out on
time and received a Freistellungsbescheid reconﬁrming our
tax-exempt status in October. Melta is now good to go
until the fall of 2022, when the tax office is sure to have
yet another reregistration process in place for us to master.
The job of upgrading the Melta website discussed at the
last AGM is proceeding apace. The aim is to make the
website much more informative, interactive and mobile-device-friendly. It’s been a somewhat bigger job than we suspected at the outset, taxing the ingenuity of designers and
programmers alike. But we’re almost there, and with any
luck, the new site will be up and running by Christmas.
Which reminds me. There’s still another highlight to come:
the annual Melta Christmas party at Gasteig on December
7. As usual, there’ll be carols, a book bazar, presentations
of Christmas-related activities you can try out in your
classes, a chance to network with other Melta members
and plenty to eat and drink. I hope to see you there.
In the meantime, I’d like to thank all of you for your support of Melta in 2019 and wish you and yours a very happy holiday season and all the best for the New Year.

Randy Perry

Message from the
Editor
What an issue we have for you! Many
experts from our Melta community
have contributed their ideas, reflections and general wisdom for this
winter edition of Melta News. Their
voices come from all corners of Munich’s ELT world: language school
owners, business English trainers,
retirees, university teachers, school
teachers and more. Thanks to all of
you who have devoted time and energy to sharing your thoughts with us. I
hope you all have happy holidays.

Tenley van den Berg

We’d like to welcome our new members!
Individual members:
Donald McDonald
Angelika Lutz
Sarah Best
Guest members:
Maithreyi Mohan
Susan Lai
Sabine Lichtl
Sarah Herrmann-Hopwood
Réka Máté
Irina Murg
Sophie Ruthven
Kelly Burton
Hema Jayakumar
Maria Eliza Geiger
Tanja Steiert
Rita Tung Mui Yau
Alessia Vella
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Article submissions can be short (~250 words), long (~650 words) or any
where in between. You are also welcome to submit book reviews, infographics, tips, brief reports on interesting articles or events, philosophical
musings, quotes—whatever you think might interest at least some of a
diverse group of English teachers. Be creative! If you would like to contribute to Melta News but are unsure what to write about, just contact us,
and we’ll find something for you.
We also have a regular section called “Teacher Clinic” in which our “agony
aunt” answers your anonymous questions. Please submit your questions
to the email below.
•P
 lease submit your article in Microsoft Word or compatible format.
•P
 lease do send pictures! Please submit pictures, illustrations, and tables
as separate files and with a resolution of 300 dpi or above.
•D
 on’t forget to add your biographical data (a picture and 30–50 words
about you).

Call for
s
n
o
i
t
u
b
i
r
t
n
Co
Melta News is published three times a year:
spring, summer and winter. Submissions are
due on 28 February, 30 June and 31 October.
And finally, have you found some mistakes in
this newsletter? Put your eagle eye to use and
join our editing team!
Please send your contribution and enquiries to
melta.news@melta.de.

We’d love to hear from you!
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Melta Five-a-Day: ice lolly sticks
Bethan Stokes shares fun activities you can do with ice lolly sticks* Why reinvent
the wheel? Many of these activities are classics for a reason. Presenting them in a
different way, however, brings something new for both students and teachers. Enjoy!

1. MIXED BAG
• Write different tenses on sticks (see
pic 1). You could also include some
sticks with symbols telling students
to make positive (+) or negative (-)
statements or questions (?).
• Students take it in turns to take a
“tense“ stick plus a “symbol“ stick
and either write or say a sentence
or ask a question in that tense.
• Repeat until everyone has had at
least one go. This can be done as
a class or pair/group activity. If
done in pairs/groups, students
could write their sentences down
and then swap them for peer correction.

2. PHRASAL VERBS /
COLLOCATION MATCH UP
• Write parts of phrasal verbs or collocations on separate sticks (e.g.
“put“ on one stick, “off“ on another).
• You could “colour” code this (e.g.
verbs on green sticks, prepositions
on yellow sticks).
• Students walk round the class and
have to find the stick with the rest
of their phrasal verb/collocation.
•
Once students have found their
partners, they have to write a definition or synonym for their phrasal
verb/collocation and two example
sentences using it. Each pair then

presents their phrasal verb/collocation to the class.

3. SENTENCE BUILDER
• Write different parts of speech on
lolly sticks (e.g. pronouns, verbs,
nouns, adjectives, adverbs, prepositions, etc.).
• Put each category into a different
container at the front of the classroom (depending on level, you
could put all or just a few categories out.)
• Students take a stick from each category and have to write or say a
grammatically correct sentence.
• This could be done individually (5
sentences each) or as a class competition (e.g. split the class in half,
one person from each team takes,
for example, a pronoun, a verb,
and a noun stick). They have to
write a grammatically correct sentence with their team. If the teams
are even, repeat until everyone has
had a turn taking the stick. If the
teams are odd, repeat up to five
sentences. The team to reach the
required number of sentences first
shouts stop. The “winning“ team
reads out their sentences and the
other team have to tell them if
their sentences are right or wrong.
If they are correct, they win the
game. If they are wrong, the game
restarts.

4. ANTONYMS /
FALSE FRIENDS MINGLE
•
Write words and their antonyms
on different sticks. Alternatively,
you could do this with German
and English false friends.
•
Students mingle to find the person with the antonym or the false
friend to their word.
• Once they have found their partner, they have to write a mini roleplay using their antonyms or false
melta news | Winter 2019/20 | no. 97
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friends and explain how confusion
could occur if you got those words
mixed up. Pairs then take it in
turns to perform their role-plays to
the class.

5. WHOSE TURN IS IT?
• Write instructions for whose turn
it is to answer a discussion question in groups (e.g. you, the person
on your left, the person on your
right, the person opposite you, the
youngest/oldest/tallest/shortest,
someone who was born in spring/
summer/autumn/winter, etc. on the
lolly sticks).

•
During group discussions, give
each group a pot with instructions
sticks. Students take it in turns to
pick a stick and tell the group who
should answer the next discussion
question.
* Buy at Søstrene Grene (Karlsplatz)
or, better, eat lots of ice lollies, then
save and wash the sticks!
Word of warning: write on the sticks
with a permanent marker, so the
words don’t smudge off onto your
hands or clothes (I learnt the hard
way…)

Bethan Stokes is originally from the UK
and has lived in Munich since September
2015. She started teaching EFL in Madrid in 2013, completed an MA TESOL
at UCL Institute of Education in 2015
and currently works at the University of
the German Armed Forces in Neubiberg.
She enjoys developing teaching materials and trying out new activities in the
classroom.
Winter 2019/20 | no. 97 | melta news

8 | Activities for the classroom

Tech Talk
Michael Saunders gives you some technical tips, tricks and suggestions for the
classroom.

Send us your tips and questions!
We’d like to make this a regular section in Melta News, but for that to
happen, we have to hear from you! Whether you need some advice on
using technology in the classroom, or you’ve got some tips to share (such
as online resources for lesson plans), drop us a line: tech@melta.de. We’ll
do our best to answer as many questions as possible in the next newsletter, or a future in-person workshop.

1. Turn a blackboard into a
whiteboard

Has your school posted you to a
classroom with only an old-fashioned blackboard? Tired of chalk
breaking, dust getting everywhere,
and horrible squeaky noises when
you write? Fortunately, there’s a way
to turn a blackboard into a much
more pleasant whiteboard-like surface. Search on Amazon for “whiteboard film” (or “Whiteboard-Folie
selbstklebend”), and you’ll find
some products for a decent price
(e.g. https://tinyurl.com/y2pg2q86
for German Amazon, €9.99). The
result isn’t quite as good as a dedicated whiteboard, but it’s still an improvement.

3. Create storyboards and
comics

2. Teﬂpedia: like Wikipedia,
but for teaching

You probably know about Wikipedia, the online encyclopedia anyone
can edit. Well, there’s a similar site
at https://teflpedia.com — “a user-generated resource for English
teachers from all over the world”.
There are many pages covering all
aspects of language teaching, from
methodology and board work to
feedback and teacher talking time,
although some of the pages are quite
short. But the best part of the site is
the list of conversation questions at
https://teflpedia.com/Category:Conversation_questions. These cover
over 170 topics, and I’ve used many
questions in my C1 “current affairs”
conversation classes. (Of course, you
can adapt them to over levels, too.)

If you want students to discuss a
particular scenario or sequence of
events, but you can’t find suitable
material, you can make it yourself
with just a few clicks. There are three
cells on https://www.storyboardthat.
com/storyboard-creator into which
you can drag-and-drop scenes, characters, text bubbles and more. Use
the tabs at the top to switch between
different items, and then the submenus underneath to narrow them
down. For intermediate and advanced students who have access to
computers in the classroom, you can
even get them to create storyboards
— you just need to demonstrate how
it works first. There’s also a video
showing the basics at https://tinyurl.
com/y8c43zhd.

Post-It and other companies sell sticky sheets to
make a whiteboard out of any flat surface

Michael Saunders teaches various
courses at the MVHS and VHS SüdOst
— from A1 beginners to C1 conversation. He earned a CELTA in 2016 and
is gradually shaking off his northern
English accent.
melta news | Winter 2019/20 | no. 97
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Teacher Feature
In the last issue, Zoe Kostarev was interviewed by Rachel McIntyre. In this issue,
Zoe, in turn, talks to Chris Lines of The London School of Business English.

You’re from the UK, originally. What
brought you to Munich in the first
place? And do you have any plans to
go back?

Good question. I arrived here pretty
much by accident. Prior to coming to
Munich, I had taught English in different parts of the world, including
Dubai and Brussels, where I worked
for the European Parliament. At
some point, I fancied a change in
scenery. My wife is a German lawyer and managed to get a job here
fairly easily, and so it seemed a good
fit. As for returning home to the UK
at some point? Well, we’re extremely
happy in “Minga” at the moment, as
it’s a beautiful city with some truly
great and friendly people. And we
have put down some strong roots,
but who knows what the future will
hold.
You’ve been teaching English for
over ten years, I believe. Has this always been with corporate clients?

My first experience teaching English
was as part of a volunteer program
in Ecuador and involved classes with
orphaned kids during the day and
classes with adults in the evening. I
really enjoyed it, and from then on,
it was a natural progression for me
to combine my interest and experience in business with my love for the
English language.

I think it’s safe to say
I don’t have much “free time”
these days!

What made you decide to open your
own language school?

A multitude of reasons, really. I
started off working for other language schools in Munich and wasn’t
very happy with the general training
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Chris Lines has been living and
working in Munich for X years. He
runs a language school, The London
School of Business English, working
with a range of corporate clients
across the city. He met Zoe when
she applied to work for him after
she’d finished her CELTA course —
and he was brave enough to give
her a chance (for which she is very
grateful!).

concepts nor the quality involved in
their teaching methods — for example sticking slavishly to one book and
not being able to use materials I had
designed myself. In short, I craved
more freedom and autonomy. My
philosophy is to choose good people I trust and to not interfere with
their teaching styles and “winning
formula”. I provide support when
they need it but don’t micromanage.
A second reason was I felt some of
the schools had a lack of respect for
their trainers. I wanted to create a
school where my trainers identified with my goals and felt treated
as equals. Creating an environment
where everybody wins — our clients,
my trainers and I— is central to my
philosophy.

website, do the bookkeeping, liaise
with and win new clients as well as
other numerous, time-consuming
tasks. As a father of a two-year-old
daughter and a second one on the
way, I think it’s safe to say I don’t
have much “free time” these days!
And when it comes to teaching, what
tips can you offer a “beginner” like
me?
Listen to the client, as they will usually tell
you what they want and need. Be patient
with beginners, and make sure every
training session is a productive use of
your client’s time. It’s a cliché, but in the
language school business, it tends to ring
true — if you love what you do, often it
won’t feel like work at all.

What are the most challenging aspects of running your own language
business?

One often hears the German idiom:
“Wer selbständig ist arbeitet selbst.
Und das ständig.” This is absolutely true. To keep overheads down
and stay competitive in the market,
I do the job of several people. First
and foremost, I train my clients in
business and legal English, but I also
design and maintain our company’s

Zoe Kostarev was born in the UK and
lived in Paris before moving to Munich
in 2009. She worked for over ten years
in sales, recruitment and management,
completing an MBA whilst on maternity
leave. She began teaching English just
a few months ago, having finished her
CELTA course at MVHS in February.
Winter 2019/20 | no. 97 | melta news
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Grantly Marshall interviewed by Joan Walsh
Grantly Marshall is something of a phenomenon. He’s been organizing foreign-language theatre in Munich for
decades now. One of the highlights of every December is his production of a musical version of A Christmas Carol.
This year, true to form, the show will also take place in Gasteig from 13–20 December. It’s an exciting event for
students and teachers alike. So, I decided to find out a bit more about Grantly, the man behind the scenes.
To start things off, Grantly, could you
tell us a bit about yourself ?

I was born several odd years ago in
Salem, Ohio, USA. I attended Leetonia High School and then Kent
State University. In 1971, I came to
Europe for a visit, had a part-time
job working in Munich on the construction of the Olympic village. I
returned to Munch in 1972, thinking I had a job with the Olympics.
But because the letters I was supposed to sign and return never got
delivered to me, the job never happened. I then stayed in Munich
and got admitted to the University.
When did you start the American
Drama Group?

In 1978.

What gave you the idea to start it?

In 1976, I joined The English Drama
Group of the University of Munich,
and, not being satisfied with its organization, formed the American
Drama Group in connection with
the American Studies Department of
the University.
How many plays have you produced
up to now?

Something around 317 or 319?

What has changed since you started?

The number of grey hairs on my
head.

Can you tell me a bit about your role
in the organization? Do you choose
all the plays and directors yourself?

I am the founder and head of American Drama Group Europe and
choose all the plays we produce.
Who are your main collaborators?

We perform for State Theaters,
Stadthallen, convention centers, high
school auditoriums, etc.
Are there other organizations like the
American Drama Group in Europe?

That´s a hard question and can’t
be answered objectively. There are
many organizations performing English, but I am aware of none that perform in as many countries as we do
(about 50 countries).

What would you say was your greatest success?

Surviving through 40-odd years of
turbulence.

What would you say was your worst
failure?

Ever getting involved in theatre at
all!!
What are your plans for the future?

Expanding, Expanding, Expanding!
South America, Asia — wherever we
can go.
Thank you very much, Grantly. We
wish you all the best for your theatrical performances in Munich —and
elsewhere — for many years to come!

Joan Walsh is from Ireland and works as
an English trainer in companies. She enjoys attending workshops and seminars
to stay abreast of the most up-to-date
trends in language teaching and technology. On holidays, she likes to travel and
learn about everything connected with
people, culture and language.
melta news | Winter 2019/20 | no. 97
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Eight Notes on the Conventions
and Rules of Commas
You’re not alone if you are confused about when you should use a comma and
when not. Mark Olival-Bartley boils it down to eight simple points.

The anecdotes of two disparate yet
timely occasions — one, unfortunate; the other, amusing — brought
the vagaries of comma use in English
to mind of late: This summer, I fell
violently ill to a food-borne pathogen whose unwieldy name, Campylobacter, alludes to its motile and
conspicuously comma-shaped design; sometime during my recovery,
delving into the tonnage of my backlog of doctoral reading, I came across
an apocryphal story about Oscar
Wilde who, mocked by a philistine
as to the lackadaisical workdays of
poets, to the effect, quipped, “On
the contrary, Sir, I spent the entire
morning deliberating the insertion of
a comma and, throughout the course
of the afternoon, laboring toward
its excavation.” All this is by way of
saying that, their pestilent wildness
notwithstanding, students of English
must learn to reckon with commas,
which differ in usage appreciably
from their German doppelgängers.

baum’s English Grammar (Oxford
UP), Webster’s Dictionary of English Usage (Merriam-Webster), and
Swan’s Practical English Usage (Oxford UP), the eight notes that follow
are meant to convey the most important conventions and rules in English
regarding commas that we ought to
bear in mind as we model their usage
and address our learners’ questions.
1. Convention: In a series of three or
more terms, phrases, or clauses with
a single conjunction, a comma may
be used after each (except the last);
this is the so-called Oxford comma,
which, counterintuitively, is more
prevalent in American than in British English.
black, red, and gold
in the morning, in the afternoon,
and at night
2. Rule: A comma is used to offset
non-essential clauses but not essential clauses.
The class, which had been bored,
found interest in the waywardness of commas.
People who live in glass houses
shouldn’t throw stones.

 ecause it is complex, English
B
punctuation allows for subtle
expressions of meaning.
5. Convention: Use a comma to offset any word or phrase that comes
before the subject of a sentence; this
is more prevalent in American rather
than British English.
Occasionally, I drink coffee in
the afternoon.
In the afternoon, I drink coffee
occasionally.
6. Rule: Use commas to offset the
noun phrases of appositives.
Barack Obama, the forty-fourth
President of the United States,
hails from Hawaii.
Munich, the capital of Bavaria,
is a wonderful place to live.
7. Rule: Use commas if words or expressions are used in unusual places
or otherwise interrupt the normal
progression of a sentence.
My students, however, did not
feel the same way about commas
as I did.
Dashes, believe it or not, are
even more supple than commas.

More so than any other mark
of punctuation, the comma is
governed more by unregulated 3. Rule: While permissible in Ger- 8. Rule: Use commas in direct speech.
Incredulously, the student said,
man, independent clauses in English
convention than outright rule. cannot be spliced with only a com“There’s no way that a comma

Yet, before we dare declaim the
use of the English comma in the
classroom, we, as the purported
language experts, must also reckon with its apparent haphazardness
ourselves. More so than any other
mark of punctuation, the comma is
governed more by unregulated convention than outright rule, which,
confusingly, not only differs from
variety to variety — from, say, British English to American English —
but from idiolect to idiolect. Gleaned
from Strunk and White’s The Elements of Style (Macmillan), Green-

ma; either add a coordinating conjunction before the comma or substitute a semicolon (or dash or colon)
for the comma.
English punctuation is highly
flexible, and it can even be fun
to teach.
English punctuation is highly
flexible; it can even be fun to
teach.

4. Convention (and virtually a rule):
Use a comma to offset a subordinate clause when it appears before
the independent clause in a complex
sentence; this is more prevalent in
American rather than British English.

should be there.”
“I’m more partial to the question
mark,” joked the student.

Mark Olival-Bartley teaches at MVHS
and leads the Amerikahaus Literary
Circle. He also tutors writing at LMU
München, where he is writing a dissertation on the poetics E. A. Robinson’s
metasonnet.
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Blackout Poetry
Students can create and engage with poetry at any level. Birgitta Berger explains
how. Birgitte led a workshop called “How to give your learners more autonomy”
at Melta Day on 21 September 2019 (see Event Reports).

Creative writing can be an incredibly rewarding way to engage teenagers in English classes, but success
depends on a couple of ifs: if they
can choose the topics and genre, if
they don’t feel overwhelmed and shy
away from the idea from the start,

and if they can involve other skills
and techniques beyond language. I
discovered that blackout poetry can
be an ideal first step towards unlocking learners’ creativity and encouraging them to experiment with language while enjoying themselves.

To create blackout poetry, take a
piece of newspaper or a page from
a discarded book and skim the text
until a word or phrase catches your
eye. Circle the word or phrase. Look
for other words to join the first word
to create a sentence or several lines.
Letters can be blacked out to change
plurals into singular; punctuation
can be “used” as needed simply by
circling full-stops, commas, exclamation and question marks. Lines
can then be drawn to connect the
words and make their order visible,
which you might need to do if you
have been “hopping” around the
page.
In the simplest form of blackout
poetry, the lines of text remaining
after the chosen words and phrases
have been circled are simply blacked
out as happens when personal data
or confidential information in documents made available to the public is
redacted. To make your work more
colourful and creative, you can use
different colours for the “blacking
out”, and you can add ornaments or
draw pictures to make the content of
your poem visible. And you can cut

They made something novel
and unique using the language
they still consider foreign.

out your blackout poem in different
shapes and forms, again adding extra meaning to the words chosen.
All you need are a couple of
discarded books, newspapers and
magazines. There are plenty of paperbacks around that have become
so shabby and discoloured that they
probably won’t find many more
readers — ideal material for blackout poetry. What else do you need?
Collect some markers, felt-tip pens
melta news | Winter 2019/20 | no. 97
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in black and various colours, scissors for cutting out
shapes and you’re ready to go. Try out a couple yourself
before you take the idea to class!
Words cannot describe blackout poetry nearly as well
as the thing itself, so here are some examples of blackout
poems, created by 14- and 15-year-old students.
For most of them, it was the first English poem they
had ever created. Not all poems made sense, but the objective was for the learners to discover that they could
make something novel and unique using the language
many still consider foreign. Most students did more than
one poem; many subsequently felt adventurous enough
to try out other poetry forms such as Dadaist and concrete poetry, cinquains, triangle triplets and diamonte
poems. The next blackout poems they create could become the first or last sentence of a story yet to be written. Poetry in EFL can be so exciting!
References
The following selection of books will give you some more examples of blackout
poetry, information about its origins, and facsimile pages to turn into your own
blackout poetry.
John Carroll: Make Blackout Poetry: Turn These Pages into Poems. Abrams,
2018.
Austin Kleon: Newspaper Blackout. Harper Perennial, 2010.
Stacia Leigh: Distance Between. Blackout Poetry and Art. Espial Design, 2018.

Birgitta Berger has been teaching
at Montessori schools in the Munich
area since 2000, working with all
age groups from kindergarten to
exam preparation in Years 9 and
10. She provides in-service training
for Montessori language teachers
through the Montessori Bildungsakademie/MoBil and the Akademie
Biberkor.
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Doing their Homework
Melta member and LMU lecturer Vivienne Arnold has initiated a new project-based
course at LMU. One of her students, Elli Danielewicz, tells us a bit about LMU’s
new magazine and interviews a student from Uni Augsburg who works on a similar
project.

At the beginning of the 2019 summer
term, a new course for LMU English
Studies and Education students was
on offer: a hands-on writing project
in which students can practice their
skills while producing a magazine
called the /ˌmæɡəˈziːn/. If the name
looks strange to you, that’s because
it’s the word magazine spelled phonetically.
However, initiating the project
wasn’t easy, which is why we decided
to interview Toby, the editor-in-chief
of a similar project that has been
running at Uni Augsburg for quite
a while. At Uni Augsburg, the class
produces a magazine called eMAG.
While
the
course
behind
/ˌmæɡəˈziːn/ teaches writing skills to
students in later semesters, the Augsburg course is a project that runs
parallel to another writing skills
seminar and is directed at younger
students who are roughly in their
third semester.
Some members of the eMAG
team also take the course voluntarily
for more than one semester and even
help to organize it. As Toby revealed
to us, “the entire course is supposed
to be run by students” who sit down
together in the semester break and
work on a — quite tight — semester
schedule. They update their teacher,
Mr. Jehle, every week on what has

been going on, and he helps the team
solve problems that arise.
To learn a thing or two, we decided to ask them a few questions
regarding how they handle it all.
Do you think the project-based way
of learning of writing skills is a better way than a traditional class to improve your English?

I believe a mix between a theoretical approach and a practical one is
useful. You can’t learn a language
simply by reading it. You have to
use it to get better at it. And part of
that certainly is writing, too, in all
its forms. But at the same time, it’s
also necessary to have a good foundation to start working on a project
such as eMAG. You need to have a
basic understanding of how to structure your writing and know the differences between writing in German
and English. And that is something
we couldn’t really learn in just one
term of one session a week.
In our course, we have tried to assign
different roles to people. What roles
do you have? Is the work distributed
in an even way?

I think a little graphic taken from our
guidelines does a better job at visualizing this than I could in words.

Group photo of the /ˌmæɡəˈziːn/ students at our launch
melta news | Winter 2019/20 | no. 97

The cover of our first edition of the /ˌmæɡəˈziːn/
(Summer 2019)

New members either work on
layouting or promote the magazine
along with working on their articles.
Both teams are supervised by team
leaders who know how everything is
supposed to be structured and help
out wherever necessary. If they don’t
know the solution to a problem, it’s
usually my job to figure something
out. I guess problem-solver would
be one of the better descriptions for
what I do.
There is a lot of organizing
things behind the scenes, too, of
course: finding printers, organizing
everything to be in line with our university, making decisions on how to
go forward or cutting inappropriate
articles, though we do try to avoid
that at all costs. Nonetheless, it happens every once in a while.
We struggled a lot to find a good
balance between the workload of the
different teams. Layouting is a timeconsuming but necessary part of it
all, which makes it a difficult area to
cut down on. Last term, we struck
a good balance by giving each member of the Media, but not the Layout
team, the task to write one addition-
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English and German:
Family Tie
How the roles are distributed at eMag

al article, which would be published on our website.
This helped even out the workload for the most part.
Our first magazine didn’t have a theme; everyone just
picked a topic. However, we now think it is best if our
magazine has a general theme for each semester’s edition.
How do you decide on a theme for each edition?

That’s one of the funnier parts of class! Each term, during one of the last sessions, we dedicate one hour to
brainstorming ideas that could be interesting as a theme.
After we have a list of potential topics, everyone gets to
vote on what will be the theme for the following issue.
Do some of those students who are studying to become
teachers plan on using the skills later in schools?

What will be useful, I imagine, are the skills you learn
without even noticing: teamwork, problem–solving,
time management. These skills are becoming more and
more important in our society.
So maybe that is our little contribution to the development of our students in the course. Most importantly,
it’s a fun time for everyone in what might otherwise be a
monotonous university day.

Elli Danielewicz is currently studying to be a
teacher of English and School Psychology at the
LMU Munich. She’s a big-time tea lover and likes
meditating and playing parlour games.

Cognates are words that look alike,
sound alike and mean the same
thing in two related languages.
German and English are full of such
vocabulary items, such as handHand, cat-Katze, house-Haus, brother-Bruder, etc. Introducing cognates
to your German-speaking learners
will make it easy for them to start
learning English and increase their
motivation.
Adverbs: Why are they so hard for
Germans? The German language
does have adverbs, but they usually
take the same form as the adjective:
Das Buch war sehr gut. Das hast du
gut gesagt! This is like the English
word fast: The car is fast. Peter
drives too fast. Compare: Das war
absolut richtig. That was absolutely
correct. So how do you make your
German learners aware of the use
of adverbs? Try this:
Ich habe meine Autoschlüssel im
Büro vergessen. Das war dumm.
Now ask your students to combine
these sentences in German: Ich
habe dummerweise meine Autoschlüssel im Büro vergessen. Nobody
would say: “Ich habe dumm meine
Autoschlüssel im Büro vergessen.” Why? Germans do change
the adjective into an adverb with
“-weise” when they comment on
the complete sentence: I left my car
keys in the office, and I think that
was dumb. The suffix “-weise” corresponds to the English way which
we use for some words (in a friendly
way, we cannot say friendlily).
By Stefan Fodor

Winter 2019/20 | no. 97 | melta news

16 | Articles

Teaching a webinar or: Leaving your comfort
zone while staying at your desk
A true story
Last December, Stefan Fodor gave his first book presentation as an online webinar. Here, he shares
with us his experience and gives us some tips if we should ever like to give it a go.

When I started my teaching career, I
never imagined that someday I would
be presenting a worldwide webinar
from my own home. But I suppose
many of us language trainers did not
anticipate our current roles when we
first began teaching.
Regardless of how our respective career paths led us to the field
of ELT, teaching means leaving
your comfort zone. There is always
a first time: teaching your very first
class, your first larger group, your
first business class, your first one-toone, your first Skype class, your first
you-name-it. In that sense, teaching
a webinar is no different. It is about
leaving your comfort zone and trying out a new format you have never tried before. And no matter how
nervous and worried you might have
been before you started, the feeling
melta news | Winter 2019/20 | no. 97

of relief and professional satisfaction
is great when you have done it (and
done it well).
Of course, you don’t start out as
a webinar presenter. It’s something
you grow into. I had been a trainer
for German and English for many
years when I was offered a freelance
position on the authors’ team of DaF
im Unternehmen, a Business German
textbook series published by Klett
(yes, networking pays off, if nobody
knows you are out there, nobody
will think of you when something
comes up).
Shortly before the end of the
project, Klett needed someone to
present DaF im Unternehmen in
Poznan, Poland, where several institutions had decided to introduce it
as their standard Business German
textbook.

I also gave similar presentations
at teacher-training courses in several cities in Germany. But although
I always enjoyed that, there was a
downside: I needed to be away from
home, and, in some cases, I had to
cancel some classes (freelancers usually don’t like doing that). And then
there was my carbon footprint with
all those airplane trips...
That’s why the idea of doing this
kind of work as a webinar presenter is so attractive: you get to stay
at home, and it is easier to fit the
workshop into your schedule. Just
like our (business) students, trainers often find it difficult to come to
a workshop in the evening or after
a long week of teaching, and by participating from home, they can also
save on travel costs. And, even more
importantly, you can reach a much
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wider audience, as trainers from anywhere in the world can join, even
from remote places where publishers would never be able to set up a
workshop.
Another option would be to give
your presentation on behalf of a
large professional association such
as Iatefl, Besig, or DaF-Webkonferenz (for German trainers). You need
the support of a larger organization,
not only for marketing purposes but
also (and even more importantly) for
technical reasons.
You may have a lot of contacts,
but most likely a publisher or Iatefl
will have more. And you don’t have
to worry about marketing the webinar yourself.
At the end of the day, you also
would like to get paid for your work.
The trainers tuning in to a webinar
usually expect to do it for free. Even
if some trainers were willing to pay a
small contribution, the mere idea of
collecting payments from all over the
world would be a logistical nightmare. So if you were trying to market your own webinar worldwide
privately, it would be unrealistic or
unfeasible to expect any income.
For a publisher, it’s a book promotion, so it’s worth it for them to pay
you a bit. And for Iatefl (or similar
organizations) it’s part of their service to the community. Usually, they
make past webinars only available to
paying members, so that is also an
argument in favour of becoming a
member.
That’s the business side. But there
is also the technical side. First of all,
you need a virtual meeting room,
which comes at a price. For my webinar, Klett used Adobe Connect. You
also need someone to work behind
the scenes to take care of questions
regarding technology, login problems or book recommendations.
The person assisting you also needs
to monitor the chat so that they can
bring interesting questions to your
attention. Your co-host has their mi-

crophone on mute, but you usually
have a private chat box.
What is the difference between
giving a regular presentation and
teaching in a virtual environment?
The biggest difference is not only
the physical but also the visual separation. Obviously, you are not in a
seminar room with a group, but by
yourself in your home office. But unlike in a virtual group meeting, you
are also cut off from your audience
visually and aurally — but they can
see and hear you. It’s a little bit like
being a radio broadcaster, speaking
in the hope that somebody out there
is listening. All you can see is a list
of participants and the chat box with
their entries, so at least you know
that some of them are actively participating. You also cannot make
eye contact, and you don’t see them
nodding in agreement or frowning if
they can’t follow your argument or
disagree.

Once you are on the air,
there is only one way,
and that is forward.

For you, as the presenter, the
experience is totally different. You
need to dress properly. You also
need to make sure that your home
office looks presentable or that you
have a backdrop that prevents participants from seeing what is behind
you. I would also avoid having personal items like family photographs,
etc. in the background, but that’s
a personal choice. And finally, you
have to think about lighting because
the participants need to see your
face properly: a bright sunny window might present a problem. In my
home office (a 6th-floor room facing
South, no curtains), I had to cover
up the windows with a dark cloth so
that the sun wouldn’t shine on my
face from the side.
Seems like a lot of preparation
and attention to detail? You’re absolutely right. When presenting a
webinar, preparation is everything.
I imagine we have all been in classroom situations where we have had
to wing it. As an experienced trainer,
you can pull it off. With a webinar, it
won’t fly. Think of a webinar more
in terms of a live TV show that has a
precise theme and a strict time limit.
Once you are on the air, there is only
one way, and that is forward.
That’s why a good script is so important. I handed in my presentation
about a week before it was scheduled to go on air. We went through
it to make sure that everything
would work from a technical point
of view, and I also received valuable
feedback that helped me judge the
length of my presentation. We actually developed a minute-by-minute schedule so that I would always

On the one hand, for your audience, it’s very comfortable. On the
other hand, they cannot communicate directly with each other (only
via the chat function); they cannot
help each other out as in a regular
classroom, and they usually can’t
raise their hands to ask a quick question. They have to formulate their questions
GREAT
VE TO BE TO
A
H
’T
in writing and hope
N
“YOU DO , BUT YOU HAVE
there is enough time at
T
T.”
TO STAR
BE GREA
the end for the presenter
START TO LAR
to answer them.
ZIG ZIG
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know if I was on track or if I needed
to speed up.
Every presenter knows (or at
least should know) that there is a
danger of becoming monotone. In a
live situation, you can spot the hidden yawns. Then it’s time to change
your pace, ask a question or alter the
pitch of your voice so that your audience can re-focus. For a webinar,
you have to plan such breaks ahead
of time. A very good method is using
an online poll, usually with multiple-choice questions so that they are
easy to answer. A poll requires your
listeners to think for a moment and
physically reach for their mouse to
click on an answer.
Usually, the whole process takes
about a minute or so. While they
are answering, you can see the bars
reflecting their various choices, and
when they have finished giving their
answers, you end the poll and publish the results. You can then comment on the outcome of the poll,
which may be exactly what you expected (perfect!) or totally different
from what you thought (surprise!).
We did this three times during the
webinar. The fourth time around,
we changed the format and asked
an open question, which required
the audience to write something into
the chat box. It’s harder to prepare
for their answers, of course, but it is
more engaging, and you come closer
to having something like a personal
interaction with your listeners.
At the end of your presentation,
there is usually time for a few questions from the audience (unless you
have taken your time along the way
and you now need to sign off in a
hurry). They will write them into the
chat box, and you and your co-host
will pick the most relevant questions
for you to answer. Unfortunately,
the format does not provide room
for engaging discussions among the
participants like what you might see
at IATEFL or BESIG conferences.
There are only disjointed comments
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in the chat box, but that is only a minor drawback.
Now, if everything has gone well,
technology hasn’t let you down, and
your brain hasn’t suddenly stopped
working, you will have made it safely to the end of your talk. If you have
ever been in a school play, a musical
performance or prepared a speech
for your grandmother’s birthday,
you know the feeling: you have put
so much work into getting ready,
and then it seems it’s all over in a
flash. This is no different.
Before you know it, you will
hear yourself making your final
comments, thanking your audience
and saying good-bye. You put your
mike on mute, turn off the camera,
take off the headphones and dash for
the kitchen to get a drink. My recommendation: put on your sports
clothes and go for a jog in the park
to get rid of the adrenaline. And
when you have taken your shower,
turn on the computer again and read
all the positive comments from your
audience! And maybe that’s the time
when instead of promising yourself
“I’ll never do something like that
again!“ you begin to think: “Why
not? It was pretty cool.“ And so you
have boldly gone where you never
thought you would go before!

Stefan Fodor is a native of Munich.
His university studies took him to exotic
places such as Rheinland-Pfalz, Ireland
and the US states of Illinois and California where he earned postgraduate
degrees in history. Since his return to
Munich in the early 1990s, he has devoted himself to foreign language teaching.
Stefan works as a freelance trainer for
German and English and as a writer of
language training materials.

English and German:
Family Tie
German doesn’t have continuous, right? Think again! There is a
German verb form that is equivalent to English continuous: Ich bin
am Arbeiten. Wir sind am Gehen.
Ich war (gerade) am Kochen, als
... “German Continuous“ is used
infrequently. German speakers
often are not even aware of it, but
once you point it out to them, they
often find it easier to get their head
around the concept of the continuous tenses. By Stefan Fodor
By Stefan Fodor
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Rich Mum, Poor Mum
In the last issue of Melta News, Susan Jane Alexiadis shared how she got the
inspiration for her business, English Native Speakers (ENS). This time, she explains —
step by step — how she turned this inspiration into to a business that runs itself.

There is so much talk nowadays about passive income.
Apparently, smart people have at least seven kinds of
passive income, whereby their money is working for
them, even while they sleep. Being a classroom practitioner, it took me a few years to get my head around this
concept. But last October, I decided to try my hand at it.
The first step was finding a need. I didn’t have to look
further than my own backyard. My daughter started
Grade 3 at our local primary school and was clearly going to be under-challenged by the regular English lessons.
Instead of complaining about the problem, I created a
solution and presented it to the teacher. It was essentially
an English extension programme, based on the Bavarian
social studies (HSU) curriculum. The teacher loved it, as
did my daughter. And, as it turned out, there was a heap
of other families lining up for it too.
Writing the learning programme was the easy part.
But how to get it out there? This was way out of my
area. My initial amateur attempts, such as sending
Google-drive links, soon proved too unwieldy and too
reliant on the “honour system”. If I was really to make a
business of this, I needed to do it right.
I thought it might help those of you who also have
a business idea if I shared what the process of getting a
business up and running is like here in Bavaria. So, here
are the steps I took, roughly in this order…

If I was really to make a
business of this, I needed to
do it right.
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1.	I registered my business at the Gewerbeamt in the

KVR in Munich. It was the nicest encounter I have
ever had with anyone at the KVR. Ten minutes and
€42 later, I was on my way. Thankfully, it was a
one-off payment. The Gewerbeanmeldung (business
registration papers) arrived by post a few weeks
later. Easy!

2.	I applied for a Umsatzsteueridentifikationsnummer

(VAT ID number) at Bundesamt Saarlouis. It arrived
a couple of weeks later by post. So far, so good.

3.	I registered my business name with the German Patent Office. This was done with the help of a patent
lawyer. It was less complicated than I thought it
would be and cost a one-off payment of €300. The
registered trademark is valid for the next ten years.
The certificate also arrived by post, but this one
took a bit longer.
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4.	I got a graphic designer, Ursel, to design my logo

8.	I set up an online payment processing platform,

5.	I found a young IT genius, Roger, to make me a

9.	I went live with the website:

and flyer.

website. He used the colour scheme of my logo
and flyer. It was my job to provide all the content
so that Roger could work his magic. He uploaded
the 180+ PDF documents that make up the programme.

6. I wrote all the website texts.
7.	I filmed 110+ videos, with the help of Roger. There
was one video to go with each task. These were
uploaded to the website using a video sharing platform called Vimeo, which ensures that the videos
can’t be pirated.

Stripe, with the help of Roger.
www.ens-programme.com

10.	I posted on expat Facebook groups Bavaria-wide.
11.	I launched a Facebook advertising campaign (again
with the help of trusty Roger!) targeting Englishspeaking families with children aged 6-11 years
living in Bavaria.

12.	I sought the help of Aktivsenioren Bayern. This is

an organization through which retired business people support the establishment of new business. My
mentor helped to implement some tighter online
security precautions to protect the downloadable
PDF documents. He also helped me make a business plan to check the viability of my business.

13. Ireclined with my feet on the desk reading a newspaper, while the money rolled in.

Well, not quite! But now that I’ve done the hard part, it is
definitely a very low-maintenance business. The website
is self-explanatory, self-service and completely automated. But I don’t think that I will ever be classed in the
category of “Rich Mum”. Maybe from one of my other
six sources of passive income that are still to come. Still,
I have helped to fill a need in the English-speaking community here in Bavaria. And, I am helping my own children reach their true potential as bilinguals. Who knows
where it may lead. Watch this space!

Susan Jane Alexiadis is an educator,
writer and translator. Australia is her
country of origin and Munich her city of
choice. An experienced primary school
teacher, Susan now writes educational
programmes for English-speaking children living in Germany. Her passion is for
language and literacy, and for her three
(bilingual) children.
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Teaching English through Food
Musing on childhood, language learning and meals, Betsy Hollweck shares her
insights into how English learning can be transformed through the topic of food.
And there’s a treat at the end!

When I was in first grade, I had a
teacher who played the violin. Every
summer, she would go to Quebec
to study and play, and thus had to
speak French. During the year, she
had no one with whom to speak
French, so to keep her fluency, she
taught us, her pupils.
She taught us the way one would
teach six-year-olds: without books
(we could neither read nor write
our own language, let alone another), speaking the way normal
French-speaking children would
speak. Of this year, I have two vivid
memories: when she taught the class
to pronounce “n”, as in “non”, we
had to pinch the bridge of our noses
so that we could feel the vibration
the letter made when properly pronounced. She also taught us how to
eat a meal.
Someone was the father, someone
the mother, and there were two children (a “typical” family). The mother cooked, the father asked when
dinner was ready, and the children
set the table. We ate meat, potatoes,
and a vegetable (I forget which it
was, but I don’t think spinach, as it
was well known that we school children hated the spinach served in our
real cafeteria; it was always a fight to
get us to finish our lunch when spinach was served).
We practiced over and over, to
where we thought that French children ate nothing but meat, potatoes and a vegetable. Oh, and there
was cake — once I made a cake for
French class; it was made of paper
with cotton balls on the top for decoration.
Today, I teach somewhat similarly (about food, that is, not the
pronunciation part), though what’s
on the menu is more likely sushi
or mashed potatoes. Mashed potatoes are very interesting — what is
“mash”? How do you do it? Is it
like “mash the bell”? What exactly
is gravy?
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Food opens a whole world of vocabulary — not just of the foodstuffs
but the terms related to it. Planting,
growing, harvesting — many “-ing”
words. Do, does, does, does not,
don’t, doesn’t (Do you like green
eggs and ham, Sam I Am?).
Shopping, preparing, serving.
Cleaning up? Do you wash the dishes, or do the dishes? Future/“going
to” — what are you going to cook
tomorrow? Will the lamb chops be
on sale? Do we even need parsley?
Modals: what shall we cook
next week? Should we invite Sheila?
Would you serve x with y? Why/why
not?

Mashed potatoes are very
interesting.

I recently taught math with food.
When one does math, it is usually
done silently, in one’s head, in one’s
own language. Yet learners need to
practice saying mathematical equations out loud. The class reviewed
the mathematical symbols and functions (addition, subtraction, multiplication and division) and their
symbols out loud, and we did a few
math examples, for fluency’s sake.
Then we role-played.
The learners worked in pairs. The
shopper wanted to buy four bananas; the merchant sold bananas, for €1
each. The shopper gave the merchant
€5; the merchant said “Thank-you”.
The shopper and the merchant had
to come to an agreement as to what
happened next. But they all had to
say, “One banana costs €1. 4 x 1 =
4, and 5 – 1 = 4. You owe me €1”.
Such interesting conversations!
One merchant had no change and
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offered an extra banana. One shopper didn’t like the look of the bananas and tried to get 6 for €5. One
looked elsewhere. One wanted to
call the police immediately to report
the merchant for theft. Two others
bargained for the whole case of bananas; the buyer could/would take
the bananas home and sell them to
the neighbors for a profit.

One student wanted to call the
police immediately to report
the merchant for theft

As we come to the end of the year
and the winter holidays, food is of
particular importance. For me, the
holiday season starts with the last
Thursday in November — American
Thanksgiving (though Halloween,
an unofficial holiday, and St. Martin’s Day, November 11, deserve a
nod as well) — and doesn’t stop until
January 6, though some of my past
Orthodox students observe until
Candlemas (February 2). Holidays
are always good sparks for conversation as well as reading/writing lessons. Once my students, all adults,
wrote letters to the Christkindl, who
comes with St. Nicholas on December 6. They wrote what they wanted, why, why they deserved what
was on their wish list, and if they
couldn’t have it, what they’d like
instead, and why couldn’t they have
their first wishes anyway (justifications)? I then distributed “Nicholas
bags” (filled with cut-out pictures of
oranges, nuts, chocolate, etc.), and
they had to describe what they’d received and whether they liked it or
not (one ate no tree nuts due to allergies). Note: make the contents of
the bags age/position appropriate.
A bottle of 10-yr-old Scotch, a tin

of caviar, a wheel of Stilton, a case
of Persian melons or tray of candied
dates. This is food, after all!
I will conclude with a recipe to
try with or without a class, and with
very best wishes for the upcoming
year:

ion and gently work into the dough.
Wrap in cling film and refrigerate for
20 minutes.

Sage and onion Christmas shortbread with cheddar and cranberry
baubles, by Alyn Williams

Roll the dough out on a lightly
floured surface to 1–2cm thick. Use
a small Christmas-tree cutter to cut
out the shortbread, place on a baking tray lined with parchment paper
and return to the fridge for 10 minutes.

Sage and onion

Preheat the oven to 180°C.

1 large onion, finely chopped
6 sage leaves, finely chopped, or 1/2
tsp dried
1 dash of olive oil
1 pinch of salt
1 pinch of pepper

Shortbread

125g of unsalted butter, softened
125g of plain flour, sifted
15g of caster sugar
1 tsp black pepper
1 pinch of salt

Baubles

150g of half fat medium cheddar
cheese, finely chopped
25g of cranberry sauce
1 tsp English mustard
3 tsp low-fat cream cheese
Place a pan over medium heat and
add oil. Once the oil is hot, add the
chopped onion and a pinch of salt.
Cook until the onions soften and
start to caramelize.
Add the sage and pepper, and cook
for 3 minutes. Remove the pan from
the heat, and spoon the contents
onto a kitchen towel to cool.
In a bowl, whip the butter and sugar until light and fluffy. Season with
black pepper.
Gradually mix in the flour and a
pinch of salt until a ball of dough
forms — you may not need all the
flour. Add the cooled sage and on-

Transfer the shortbread to the oven,
and cook for 8-10 minutes until
golden brown. Remove and allow to
cool on a wire rack.
Add all of the bauble ingredients to
a blender, and blitz into a smooth
purée. Transfer to a piping bag with a
5mm nozzle. Once the trees are cool,
pipe little dots onto the “branches”
of the shortbread and serve.
Note: To serve with drinks (wine,
etc.), leave off the baubles. You can
use a cutter of any shape.
“Life is weather. Life is meals”.
Light Years, by James Salter

Happy Holidays!

Betsy Hollweck graduated from
Fordham University (NYC) with a B.A.
in Linguistics. She completed her CELTA
certification in Munich in August 2017
and lives in Baldham where she translates menus, recipes and other things
needing gastronomic edification: she
also teaches privately and at the VHS in
Vaterstetten.
Winter 2019/20 | no. 97 | melta news

24 | Event Reports

Vocabulary: Teach, Rinse & Repeat
Tim Howe reports on the Melta workshop led by Adam Bandstra
on 20 July 2019.

Always on the lookout for innovative and more interesting ways of
teaching vocabulary, I had great expectations of this session. Subtitled
“Vocabulary: how we think about
it, what we do with it, and how we
teach it”, it sounded as if it would be
just what the doctor ordered.
Glancing around a packed room,
Adam Bandstra is visibly overwhelmed. “Cool,” he says, “I’m
standing in front of a group with
400 years’ experience.” Adam immediately taps into this experience with
a brainstorming activity. “What
sort of vocabulary do you teach?”
he quizzes. We suggest all the usual
things — nouns, adjectives, adverbs,
links, business vocabulary. Flashing
up a pre-prepared slide, Adam adds a
few more ideas to the mix, including
hyponyms. “What are those?” some-

Adam Bandstra has a BA in English
and Post Independence Indian
Literature, and an MA in Applied
Linguistics and English Language
Teaching from King’s College,
London. He also holds the Cambridge Diploma in English Language
Teaching for Adults (DELTA with
Distinction) and the Cambridge Diploma in English Language Teaching
Management (DELTM with Merit).
He has worked as an English language teacher, curriculum designer,
translator, teacher-trainer, academic
manager, business communications
trainer, and school principal in the
USA, Germany, the United Kingdom, India and Turkey. Currently he
works as a Business English trainer
in and around Augsburg and is a
committee member for IATEFL’s
Teacher Training and Education SIG.
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“Create a Tinder ad,” offers
one tech-savvy colleague.
“What’s a Tinder ad?”
asks another.

one asks. “A member of a broader
class,” explains Adam. Well, we’d
certainly learnt something new there.
Adam then proceeds to invite suggestions for what to do with all these
words. “Create a Tinder ad,” offers
one tech-savvy colleague. “What’s a
Tinder ad?” asks another.
Next up is a slide showing pictures of some 100 objects. As we discuss all the different ways of exploiting the material depicted, we enter
what’s probably the most useful and
hands-on part of the workshop. Suggestions include:
• memory game
• categorising the words into our
own categories and guessing
what’s in each other’s category
(Adam obviously likes categories.)
• to whom would you give these
gifts?
• which items had you ever returned
with a complaint?
A dab-hand with graphics, Adam
next produces a slide of verb groups,
encouraging us to link them with
words from a list of nouns and
then create stories with these word
matches.

In his final activity, Adam hands
out a legal text (“Time Limits in Detention”). Again, what would we do
with it? Suggestions include:
• pick out key words, passives,
modals
• translate into plain English
• do a roleplay
From his activities, it is clear Adam
champions the teaching of words
through groups and categories, coupled with any type of vocab-boosting
task to do with ranking. I also like
his suggestion to use the song “If I
were a Boy” by Beyoncé for If-clauses. Pity the internet wasn’t working,
though. That perhaps needed better
preparation.
On balance, this was an enjoyable workshop, and Adam certainly
sensitised us to all the different types
of vocabulary we need to be teaching. With our 400 years of combined
experience, however, I suspect most
of us have been doing this for some
time already.

Tim Howe provides training, translating
and interpreting to business and higher
education. He blogs about the brighter
side of expat life at
https://knowhoweforenglish.blogspot.com/
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Warm-up:
Students take a picture of something with their smartphones (for
those who don’t have one, they can
choose something from a magazine/newspaper/flyer, etc.). If it’s in
English, then all the better. It could
be a building/advertisement /item
for sale, whatever tickles their fancy.
Students should be able to talk
about their picture for one minute
and give reasons why they chose it.
This activity can generate a lot of
speaking practice/interaction and
sometimes extends far beyond the
usual 5 to 10-minute warmer slot.
Encourage other students to ask
questions relating to one another’s
contribution.
By Breda Howe-Helmecke

English and German:
Family Tie
Germans are always so exact, so
why is their future tense so sloppy?
Germans often have problems with
expressing the future in English
because, in German, a statement
in the present tense (Ich gehe in
Rente), combined with a future
reference that indicates an even a
more distant future (in vier Jahren),
will usually suffice. Using the real
future tense would often be understood as too big and exaggerated
(Ich werde zum Bäcker gehen —
I shall indeed go to the bakery), so
Germans tend to save it for strong
emotional statements (Ich werde
dich nie verlassen).
By Stefan Fodor

Volunteers needed
The refugees and asylum seekers arriving in Germany over the last few
years have faced many challenges. Not only have they had to adjust to life
in overcrowded, poorly equipped and understaffed shelters or other forms
of substandard accommodation, they’ve also been compelled to learn
German. To help them, the government and private organizations have
set up special language programs. The expectation is that these programs,
which are largely grammar oriented, will enable refugees to attain B1 competency within a relatively short time. To date, the failure rate is nearly 50
percent. And now another difficulty has raised its ugly head. To have any
chance of succeeding in the German school system and/or on the German
labor market, it turns out that refugees — both children and adults —
must also know English. And for that, there’s very little extra help available
from either the overstretched public school system or private organizations. The task, however, is not a difficult one, particularly for experienced
English teachers. It consists primarily of helping students do their English
homework and improve their speaking skills. Under the circumstances, a
little tutoring can go a very long way.
So if you have a couple of extra hours a month and would like to
lend a hand, Elif Beinert at the Münchner Flüchtlingsrat (aktiv@muenchner-fluechtlingsrat.de) would be very happy to hear from you. You can tell
her that Melta sent you. (Melta Chairman Randy Perry is a volunteer for
this organization.)
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Reﬂections of a Dinosaur
Fran Vince reports on the Iatefl Business English Special Interest Group (Besig)
conference, which took place 11–13 October 2019 in Berlin. The theme of the
conference was “Back to Basics”.

The dinosaur? It’s me, I admit, with
more years than I can recall of English teaching behind me. The Besig
annual conference, at 32, is a mere
youngster by comparison but an
amazing event nonetheless!
In lecture rooms bearing impressive names such as Einstein Cabinet,
Curie Cabinet, Newton Cabinet,
Pasteur Cabinet or Bunsen Saal, we
were able to enjoy a wide range of
topics, talks and workshops. I do declare that the conference gets better
every year. Besig means business, and
business-like it has become: it runs
more efficiently and uses vastly improved technology. Remember the
old days when nearly every session
experienced a glitch of some sort?
We were amateurs at the game 32
years ago, no less dedicated in our
work as teachers, I am certain, but
lagging behind the business world
that we were attempting to teach.
This conference, working together with the Global Issues Sig, called
upon us all to think “back to the basics”. It looked at then and now. It
also went one step further by asking
us to consider the impact we all have
personally on society today and on
core issues such as sustainability and
environmental protection and how
we, as teachers, can help.
Helen Strong gave a lively foodfor-thought session called “How to
Live the Life you Want”. She told us
that she’d upped and left England as
her 30th birthday was approaching,
turning her back on her home, her
job, her husband and even her dog.
She settled in Germany, began teaching business English, and recently,
with her 50th birthday looming on
the horizon, decided it was time
for another life change. This year
she moved to the Outer Hebrides,
started up a B&B on a tiny, very
romantic-looking but extremely remote island where she also offers life
coaching for those guests who would
like it. Not that I am altogether sure
what a life coach is or what I would
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learn from one, to be honest, but
that is going back to the basics with
a vengeance.
I attended sessions on how to
teach online, face challenges in a BE
classroom, develop a career as an
intercultural trainer, teach presentations, customise, coach and much
more, but what I enjoyed greatly and
perhaps even remember best were the
plenaries. This year there were three,
with the final one taking place right
at the end of the conference. They
were three very different plenaries by
very different speakers bearing very
different messages. We were treated
to a mixture of romance, parsnips
and new-age!

We were treated to a
mixture of romance,
parsnips and new-age
On the Friday, Anne Kankaanranta considered the dynamics of English
as a corporate language and talked
about BELF — Business English as
a Lingua Franca. She mentioned an
event that had given her food for
thought. Talking to students in a
company where the corporate language was English, she asked them
how easy or difficult it was for them
to communicate in the English language. They found communicating
with colleagues, in meetings and presentations not difficult at all. However,
they found official reports and briefs
that came from HQ very difficult
— so difficult, in fact, that they simply ignored them! So, the language
of business English can, therefore,
be split into two — the English for
everyday life in the company and the
official, more formal, written English.
On the Saturday, Steve Brown
gave an entertaining, if somewhat

doom-and-gloom, talk on life today
and the role we have to play in it. His
talk was entitled “Indoctrination,
Empowerment or Emancipation?”
on the role of ELT in global society.
We were shown dramatic scenes of
natural (and other) disasters, including a picture of a certain gentleman
who is running the scene in the USA.
Can one call him a natural disaster,
I wonder?
Steve complained that most
coursebooks today are far too globalized and hence do not cover the
PARSNİPS (the taboo topics — Politics, Alcohol, Religion, etc.), which
he feels is a great pity. People in
Scotland, he explained, like talking
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about alcohol, but you will never
find it mentioned in a coursebook,
he says, because these books are also
used in the Muslim world where people may get offended. I would like to
challenge that statement, however, as
most trainers supply extra materials
of their own or download from the
internet, don’t they?
Steve did not actually say that we
are getting it all wrong as teachers,
but he feels we are not getting it all
right either. We could do far more
towards educating people to recognise and help with the enormous
problems the world is facing today,
a more socially responsible approach
to ELT.
Plenary number three was what
I would like to call “new-age” as
far as plenaries go. It was dubbed
“Business English Trends: Two Ians
in Dialogue”. Ian Badger is a book
author and business English trainer.
Ian McMaster is the editor-in-chief
of the business communication
magazine Business Spotlight. They
each began by giving brief, five-minute roundups of the talks they had
given at the conference. With Business Spotlight turning 20 years old
this year, Ian M had given a talk on
20/20 visions, based on his 20 years
of research. They then retired to

comfortable chairs at one side of the
stage where they engaged in a kind
of chat show, exchanging experiences and firing questions at each other
and discussing the problems trainers
and publishers will face in the future.
Ian B questioned what Ian M meant
by the comment “merely being a
good listener” is not enough. Well,
the good listener also needs to ask
relevant, pertinent questions. They
discussed topics that ranged from
problems involved in understanding native speakers to the future of
publishing. They also addressed the
question: will everything be online
in years to come? I found the session
highly entertaining and a great way
to round off the conference — it kept
us awake and sent us home with a
number of things to reflect on!
Before I sign off, I should like to
say a warm thank you to the Besig
organisers and joint coordinators,
Dana Poklepovic and Evan Frendo,
and their team of helpers behind
them. We saw and heard more of
Evan as he introduced the speakers
and topics at the plenaries and gave
other announcements. He has such a
strong, yet warm, clear voice that I
could listen to for hours! Hope that
comment does not make your ears
go red, Evan!

Fran Vince has taught English all her
life. She studied English and music in
London, moved to Germany in her early
20s and founded Vincenetenglish in the
90s. She now lives in Turkey, from where
she acts as back “of beyond” office
for her daughter Heidi, who now runs
Vincenet. In Alanya, Fran assists on the
foreigners’ committee, is a member of
the German–Turkish society and enjoys
singing in an international choir.
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Melta Day 21.9: Got a question about
using technology in the classroom?
Susan Merz and Miles Parker team up to report on the Melta Day workshop by
Michael Saunders (see bio on p. 8) and Nik Granchev. You can find notes from the
workshop below the report.

The afternoon session of this year’s
Melta Day was held, as usual, indoors at the Gasteig, while the outdoor temperatures of this sunny day
reached an almost scorching 20°C.
Nonetheless, among several other
contributors to this year’s special
day, two cool computer geeks, Nik
and Michael, were in top form to introduce us to, and help answer our
questions about, technology in the
classroom.
Nik, who was raised in Bulgaria, sees himself as a digital native.
Michael, on the other hand, is from
northern England and has been a
computer journalist for the past 20
years. He has recently realized that
teaching English is “way more interesting”!
They began their presentation by
explaining the importance of choosing secure passwords. By way of
clarification, they introduced us to
an episode of “Last Week Tonight”
starring John Oliver together with
Edward Snowden. This humorous
TV spot proved to us the importance
of using so-called password phrases
instead of mundane hackable passwords like 1,2,3,4,5,6! After watch-

Nik Granchev, committee member and Melta’s web administrator
is originally from Bulgaria and is
always ready to support us with our
technical issues. “I came to Munich
eight years ago to study. I completed my CELTA in August 2018 and
have been enjoying teaching ever
since. I like to use technology in the
classroom to make things simpler
and to have more variety in my
lessons. I love to travel and meet
new people!”
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ing this, we were
asked to create some
of our own. It could
be a short saying or
a fact about yourself which could be
expressed using capital and small letters
interchanged with a
mixture of numbers
and figures. Example: I Like ice cream
in the summertime.
ILiC1ts.
How to spot and
watch out for “phish- Our techy teachers: Michael Saunders (left) and Nik Granchev (right)
ing emails” was anSumming up, the information
other topic our Melta boys covered.
We were urged to check the sender was extremely useful and presented
address carefully and to watch out for in a lively and informative manner.
funny characters and mistakes in the The dynamic duo, Nik and Michael
— two tech wizards — succeeded in
written text.
As alternatives to using common giving very quick, qualified responsweb tools such as Google or Micro- es to our many haphazardly spontasoft Office, we were urged to try sites neous questions. These young men
such as Duck Duck Go rather than provided us with a bright and intelliGoogle. Libre office, a nonprofit or- gent overview of a variety of technolganization that doesn’t collect data ogies, which can be very useful for
and is compatible with Word, was the ESL classroom.
This proved to be another high
suggested as a substitute to Micropoint in a well-organized Melta Day.
soft Office.
Most of us agreed we could use
The session also included ideas
for using an array of online websites more sessions like this throughout
which offer readymade lesson plans the year!
(always welcoming words to harried
teachers) based on Ted Talks and
YouTube videos. One example they WORKSHOP NOTES
showed us was eslbrains.com, a free by Nik Granchev
website offering student and teacher
Technology tips and resources
worksheets.
Snowden
on
passA word of warning from our tech Edward
geeks concerned the using of USB words: https://www.youtube.com/
sticks in internet cafés or on public watch?v=yzGzB-yYKcc
computers: beware of viruses! For
virus protectors, they recommended Use two-step authentication where
Avast and Bitdefender; Wondownde- possible – e.g. when you log into a
site, you also get a message sent to
fender is also OK.
As a final word to the wise: keep your phone to confirm. Most major
your data on an external hard drive! online services provide this. AlternaFor this, Google is quite secure, they tive web browsers with extra security
said. On the other hand, we should built in: Firefox (https://www.mozilBrave
be careful where we store our pic- la.org/en-GB/firefox/new/),
(https://brave.com)
tures.
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If you use Firefox, add an extension
to block adverts: https://addons.
mozilla.org/en-US/firefox/addon/
ublock-origin/
Alternative encrypted email in Switzerland: https://protonmail.com
LibreOffice, the entirely free office
suite, made by a community and
compatible with Microsoft Office:
https://www.libreoffice.org (Download instructions: https://www.youtube.com/watch?v=qdEUlcby0A4,
installation instructions: https://
www.libreoffice.org/get-help/install-howto/
In LibreOffice, use change tracking to show changes you make to a
document. This is useful if a student
sends homework, and you want to
show what you have changed and to
add comments. In LibreOffice Writer,
the word processor, go to the menu:
Edit > Track Changes > Record (and
Show). You can also go to Insert >
Comment to add a comment.
ESLBrains – videos with lesson plans:
https://eslbrains.com/filter-bubbles

Q+A session
Transferring your coursebook audio
files to your computer
Put the CD from the book into the
CD Drive of your laptop/computer.
Then open Windows Media Player.
On the left side in the panel, click on
the CD drive (Usually CD Audio (E:) )
After that, in the top panel next to
create playlist and organise, you can
find a button — RIP CD — press it
and then wait for the process to finish. You can find the files in the default Music directory — Local Disk
C: users>username>Music.
Add QR codes — fancy barcodes —
to printed materials so that students
can scan them on their phones to
access things on the internet. For in-

stance, if you want students to see a
YouTube video, first go to YouTube,
find the video, then copy the full video address from your web browser
(select it, right-click, copy). Then go
to http://goqr.me, click the globe on
the left to enter a URL (website address), then paste it into the box. A
QR code should be generated on the
right. Click Download to save it to
your computer – now you can add it
to any printouts you’re making.
You can use presentation software to
reveal an image a little bit at a time,
which is useful for some classroom
activities. In LibreOffice, create a new
presentation (in the menu, go to File
> New Presentation). In the following
dialog, “Select a template”, just click
Cancel — you only want a blank one.
Then go to Insert > Image in the menu
and choose the picture you want to
reveal. Place it on the slide and use
the handles at the corner to resize.
Next, go to the menu and Insert >
Shape > Basic > Rectangle. Click and
drag to draw a rectangle over part
of the image. With the shape selected, go to Format > Animation in the
menu to show the sidebar on the
right. Click + to add an animation,
then choose Exit for the category,
and Disappear for the effect. If you
now go to the menu and Slide Show
> Start, you can see the shape disappear as you keep going through the
slides. You can now add more shapes
and the same type of animation to
cover the rest of the image.
In Microsoft Office, create a blank
presentation. Then go to Insert >
Image in the menu at the top, and
choose the picture you want to reveal from your computer. Place it on
the slide, and use the handles around
the picture to resize.
Next, go to Insert > Shape > Rectangle. Click and drag to draw a rectangle over part of the image. Click on
the newly created rectangle and then

go to Animations (in the menu at the
top). Open the big white box in the
top left with different animation effects. Scroll down to exit animations
and choose one to your liking. (simple disappear recommended).
If you now start the slide show by
pressing the button in the bottom
right, you can see the shape disappear as you keep going through the
slides. You can now add more shapes
and the same type of animation to
cover the rest of the image.

Miles Parker is from Maine, and he
loves living in Munich. During the summer, he likes to putter around his veggie
garden, and in the winter, he’s often
found at the Film museum watching a
movie. Nowadays, he works mostly at
the VHS, which gives him a chance to
meet people from all around the world.

Susan Merz, originally from Toronto,
Canada, currently teaches and coaches
business English students at companies south and west of Munich and
does some translating on the side. Her
passions are hiking, skiing and travelling,
especially to Italy where she completed
her CELTA certificate in Rome. She has
been in Germany for longer than she
can remember, is the mother of 3 adult
children, and enjoys living in Starnberg
with her handsome Golden Retriever,
Pino.
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Melta Day: Voice training
with Frances Lucey
Diaphrams and uvulas: Tim Howe (see bio p.24) reports on Frances Lucey’s Melta
Day workshop
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What does a classical opera singer
and a teacher have in common? They
both need to work tirelessly on voice
production and clarity to do their
job effectively. While this might be
de rigueur for opera performers, it’s
a skill that’s often neglected in teaching. So, when professional opera
artist Frances Lucey offered a coaching session in the art of clear voice
production, I naturally leapt at the
opportunity.
After (nearly) an entire day of
sitting, the Dubliner’s plan to get us
off our seats, stretch our legs and
move us around to perform various voice-training exercises was just
the ticket. Frances kicked off with
some warm-ups for our vocal cords,
challenging us to break out of our
comfort zone. This largely involved
having us repeat “mamma mia!” at
various pitches. We might have been
forgiven for thinking we were auditioning for a particular West End
musical. The best was yet to come,
however. “Ever wondered why performers pull funny faces before they
go on stage?” the soprano asked after we’d notched up almost a dozen
“mamma mias!” “They’re loosening
up their muscles,” she winks.
Next up, we paired up and practiced exhaling at a piece of paper
placed halfway between us. If the paper moved, it meant we had used our
diaphragm. A flattened diaphragm,
Frances explained, keeps a supply
melta news | Winter 2019/20 | no. 97

of air in the lungs which, when released, is used to support the mouth
for effortless singing — or teacher
talking. It holds the air in the body
and gives the performer control of
a steady breath. It turns out that
steady breathing, often the first point
of study in classical voice training, is
essential for teachers, too. Without
good breath support, the voice fatigues quickly — something we’ve all
experienced in the classroom.
Although Frances made it seem
like child’s play, I was already having trouble following some of the instructions. Of course, it could have
just been that my concentration was
waning after today’s wall-to-wall
workshops. “You have to depress
the root of your tongue and lift your
soft palate,” the singer encouraged,
before going on to emphasise the
importance of the uvula (the narrow
muscular structure at the back of the
mouth). Noting my difficulty in trying to locate my own uvula, Frances
instructed me to say “Aahh!” Smiling at the result, she added, “You
can’t see your uvula right now, but
your partner can.” For a split-second, I wasn’t sure whether to feel
embarrassed or relieved.
No prizes for guessing the grand
finale in our quest for the perfect vocal projection. Frances flashed up the
lyrics of “Mamma Mia”. Before we
could say “Abba”, we were singing
the full song at the top of our, by

now, impressively breath-supported
voices.
Was the session helpful? The sixty-minute taster certainly was fun,
albeit somewhat hurried and confusing. Still, when it comes to making
ourselves heard in the classroom,
Frances Lucey has certainly sensitized us to the importance of both
breath and vocal production.
Would I do it all again or
come back for more? For another
group-binding bash at Abba, definitely yes.

Frances Lucey comes from Dublin
where she studied Music and French
before joining the Bavarian State
Opera Studio to finish her training
as an opera singer. She was subsequently a soloist in the National
Theatre for eight years before leaving to join the Gaertnerplatz Theatre
where she still sings. In August
2018, Frances completed a Celta
course and is now teaching English
as well as singing.
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Melta Day: Simulation Light
Engaging business English courses, simulation light and a dating agency for “the
undateables”: Ilá Cristina Coimbra gives us a brief account of Dana Jelinkova’s
Melta Day workshop.

September 21 was a sunny Saturday
and the first day of Oktoberfest: all
the reasons in the world for a great
part of Munich to be somewhere
outdoors having a Maß (or three).
However, that was not exactly what
happened at Gasteig that afternoon.
In fact, the excitement seen in room
3145 had nothing to do with beer
or sun: we were all gathered to take
part in a day full of sharing experiences and attending brilliant workshops on Melta Day.
Among so many inspiring sessions about learners’ autonomy
and technology, Dana Jelinkova
was there to share with us ways to
deliver engaging business English
courses that have maximum output
from the students. She called the
technique “simulation light”. The
course is based on the topic of setting up a business and planning all
the steps to do so. From drawing up
a business plan and getting investors
to planning a launch event, students
have to continually make decisions,
express their opinions and negotiate
throughout the process of setting up
a company.
To make us experience how much
output this approach to teaching
business English can generate, Dana
put us into small groups and distributed a handout in which we could
draw up a business plan to present
to investors. On this paper, we had
to fill in some fields.

Dana Jelinkova has taught numerous general and business English
courses in Prague and Munich and,
as a CELTA tutor, enjoys the challenge of training future teachers.
melta news | Winter 2019/20 | no. 97

First of all, we had to decide on
the type of business we wanted. There
were some suggestions to choose
from: a bar, a coffee shop, an estate
agency, a courier service, a dating
agency, etc. This last option was the
one my group decided to go for. The
first thing we did was to write a brief
description of the business. Inspired
by Channel 4’s documentary series
“The Undateables”, we decided to
start a dating agency that would suit
people who are deemed not eligible
to be dated because they didn’t meet
typical beauty and social standards.
By the time we had decided this, we
had already outlined the service we
were going to offer and the name of
the business.
The handout also had sections
to encourage us to reflect on market
trends, the location of our business
— which we agreed should definitely
be near a romantic park — the objectives for the first months and the
target customers. Last but not least,
we had to think about the prices of
our service. As we wanted our agency to be a face-to-face service, we
based these costs on the number of
computers we would need, the size
of the place we needed to rent and
the rent itself.
After drawing up our inspiring
and fun business plan, we presented
it to the other group as if they were
investors. Then, after convincing
the big sharks we were worthy of
their money, we set out to plan the
launching event. The other group
also had a business plan to present
to us as if we were the big sharks
for them, and it turned out our businesses were complementary: they
had set up a bookshop café. So, we
joined forces and decided to launch
both our businesses together in a
joint event, which intensified and
enriched the discussion. The final
task was to draw a poster and present our project, services, marketing
strategies and party planning to the
other groups.

If we analyze the linguistic output
in this simulation, we can see a wide
variety of communication skills and
language structures that are key for
business English learners. Here is a
brief list of some possible linguistic
outcomes and the steps that are connected with each:
•
Language for negotiating, suggestion and persuading: deciding on
the type of business, on the name
of the business and on the managing team. For example: “I agree
that a coffee shop is a very popular
place; however, there are already
too many in Munich. Why don’t
we go for the courier service?”
• Relative clauses: describing the
business. For example: “It’s a dating agency that focuses on people
who don’t conform to social standards”.
• Language to state opinions: deciding on the type and name of the
business, drawing up the marketing
plan. For example: “I don’t think
we should have an online service.
I believe our target customers need
more face-to-face interactions”.
• Modal verbs, speculation and prediction: discussing market trends,
estimating start-up costs and service costs. For example: “We might
need three computers to register
the profiles and run the matching
program” or “We will need at least
20 paying members in the first
three months”.
• Connectives and conjunctions for
explaining reasons: deciding on the
location of the business, planning
the launch party, presenting costs
to investors. For example: “We
need our agency to be near a park
because it is more romantic” or
“Since many of our customers may
be introverts, a bookshop café is
the perfect location for the launch
party”.
The possibilities are amazing and almost endless. Also, if we think about
structuring a course around the top-
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Melta Day: How to give your
learners more autonomy
Zoe Kosarev (bio p. 9) shares some of her impressions of the Melta Day
workshop given by Brigitta Berger (bio p. 13).

ic Dana brought us, we can plan a
business English program that can
not only be useful and generative in
terms of language but can also be engaging, interesting and transformative. The students might discover, for
instance, that they are good business
planners or might find out they actually would like to have their own
business.
Our group realized, after performing all the steps of the simulation, that we would love to run a
business that could make a difference in people’s lives and make some
money. Although I truly believe that
making a difference is why we became teachers in the first place.

Ilá Cristina Coimbra has been an
English teacher since 2001 and a teacher
trainer since 2011, primarily focused
on preparing students and teachers for
language exams. Ilá holds DELTA Module
2, CELTA and CPE certificates and has
been attending and presenting at local,
national and international conferences
since 2014. She is also the author of
Raise Up!, a coursebook that aims to
make the ELT classroom more inclusive
and diverse, and she is one of the founding members of BRAZ-TESOL Voices SIG,
a special interest group that focuses on
equality in ELT.

On 21 September, I attended an
excellent and thoroughly enjoyable Melta Day event. We had lots
to take away with us — some of
which I have already applied in my
lessons. The event began with a
great workshop given by the lovely
Birgitta Berger centred on how to
give your learners more autonomy.
Using her experience and Montessori background, Birgitta introduced us to various methods and
activities that “enable students to
take control and responsibility for
their own learning”. Autonomous
learners should feel a greater willingness to learn (particularly useful
when teaching children or teenagers) because they are taking charge
of their own learning, adapting
where necessary to suit their needs.
They often show higher levels of
motivation, especially as they are
able to judge their own successes
based on personalised goals.
Birgitta put theory in action by
introducing us to a range of activities we were able to practice during the workshop. These included
authentic communication activities such as word ping-pong and
word snake. We also looked at
learner-created materials such as
word cards and dominoes. Much
amusement was had when it turned
out not all the participants were
completely clear on how dominoes worked — and Birgitta accepted that some ICQs (Instruction
Checking Questions) would have
been useful at that point.
We also did a pictures and questions activity in which we chose a

picture and wrote four open questions based on the image that were
then used as the basis for a discussion. These images and questions
(as well as the dominoes, word
cards, etc.) can be kept, labelled
and used again.
All of Brigitta’s activities focused
on communication. The teacher
can encourage the use of the target
language by ensuring that the images and vocabulary practised are
relevant and by correcting mistakes
either at the time or later.
All the participants were thoroughly engaged in this workshop.
We made new friends, laughed and
discussed loudly — the 90 minutes
flew by! Thanks again, Birgitta, for
such an interesting workshop.
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Fierce Conversations
Reviewed by Jeff Aristy

Published in 2008, Fierce Conversations, by Susan Scott, is certainly
not a new book. However, despite
its age, Fierce seems to have started
something. It has inspired a successful management training concept,
paved the way for several other titles that cover similar
terrain and brought
urgency to the idea
that we need to start
talking — right now
— about the things
that are deeply problematic in working
life.
As a former CEO
of several American
companies, Scott saw
how communication
is failing: pointless
meetings, conflicting
priorities and multiple projects are never fully aligned with the people and
functions they affect. Her book explores what communication is, why
don’t we communicate and then,
after investigating those fundamental questions, she begins to lay the
groundwork for how to have an effective conversation.
Scott uses the word “conversation” understanding how abstract
and multi-layered the word “communication” has become. Fierce is
about clarity, and, to achieve this
clarity, Scott takes us back to the
core principles of effective conversations: asking meaningful questions,
showing empathy and listening to
people — committed listening is
hard work, but necessary.
The book is also chock-full of
interesting quotes: “While no single
conversation is guaranteed to transform a company, a relationship, or
a life, any single conversation can.”
Here, she is reminding us of the potential value any meaningful conversation can carry and how “any single
conversation can” change everything.
A valuable sentiment inviting us to
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look back on our own lives, at those
important moments (the day we
met our partner, an evening with a
friend, that job interview) that powerfully evidences how our lives very
often twist and turn and depend
upon unexpectedly important conversations. “Speak
and listen as if this is
the most important
conversation you will
ever have with this
person,” she writes,
arguing that if we
can achieve the right
level of commitment
to the person we are
speaking to, something wonderful may
emerge.
Fierce Conversations is about being
strong, powerful and
authentic in the moment, which Scott qualifies by writing this: “A fierce conversation is one
in which we come out from behind
ourselves, into the conversation,
and make it real.” This is another
reminder that much of the communication we think we are engaging
in is more about pretence, protecting self-esteem and creating smoke
screens that conceal and constrict
communication rather than liberate
it. Scott touches upon these uncomfortable realities about human behaviour and how, especially in cor-

Jeff Aristy is the founder and Managing Director of Big Apple Business in
Munich, Germany, a company specialising in coaching, training and consulting
services. j.aristy@bigapplebusiness.de,
www.bigapplebusiness.de

porate life, adults struggle with the
risk of self-disclosure. These truths
might be at the heart of why communication is perennially failing and
that fear may be a major driver of
human interaction. The book gives
the reader a kind of mandate to become more courageous — to become
more fierce — in our interactions in
order to open up opportunities.
To help us achieve this, Scott provides four key objectives we need to
bring into our interactions:

Objective 1:
interrogate reality

Reality, Scott argues, is complex,
multiple and is always competing
with itself. We do not own the truth.
Consequently, every time we talk to
another person, we need to be in a
mode of enquiry. This sounds sensible. However, if we look at corporate life, we very often see a belief
in expertise and knowledge, a belief
that I am right and you are wrong. It
is these entrenched beliefs that might
be undermining the ability of individuals and organisations to communicate productively.

Objective 2:
provoke learning

A fierce conversation means that we
should always walk away from the
conversation with something new
gained from or something new given
to the person with whom we’ve been
speaking. In some of the more memorable anecdotes in the book, Scott
recounts how many corporate leaders often have “versations” rather
than conversations. This means they
talk at someone rather than with
someone and how this data dumping offers little value or relevance to
the listener.

Objective 3:
tackle tough challenges

Here Scott returns to the fear factor.
She says that many competent business professionals are not having the
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Losing my Voice and Finding Another
Reviewed by Tim Howe (see his bio on p. 24)

right conversation and not saying
what they should be saying in a
meeting, to a colleague or a team
lead. Business English trainers all
know the scenario where our clients complain about what they
find frustrating about their jobs,
rather than having a conversation
with their boss or colleague about
a difference of opinion.

Objective 4:
enrich relationships

While it is possible to fulfil objectives 1–3, we can still leave people feeling frustrated in the end. A
problem might have been solved,
but the relationship is left unimproved. That means we need to
ensure that every conversation
should be designed to foster relationships as the foundation of efficient collaboration.
Scott’s philosophy about communication is relevant and pragmatic. Her ideas are simple yet present a fundamental shift in how
we should engage with others. As
practitioners in ELT, Scott’s book
is also confrontative for us, asking if we, too, should think about
bringing “fierce” into the classroom so that our clients can better
meet the challenges of corporate
life.

Non-fiction
widely
documents the language acquisition of
young children, but
there seems to be very
little written about
how adults gain language after growing
out of the “soak-it-up”
stage. In his book Losing my Voice and Finding Another, Cooper
Thompson seeks to
fill “this market” gap
by describing the urge to express intense feelings towards others, yet not
possessing words to utter these in a
foreign language.
Linguistic dispossession — wanting to communicate certain feelings
but lacking the words — is something many elderly readers can connect with. Particularly those who
have had to learn a hard language
from scratch. Thrown in at the deep
end after marrying a German woman
and moving from the U.S., Thompson faced this very conundrum. As a
middle-ager who still resists the pressure to learn Polish after wedding a
Pole, I can certainly connect with
Cooper Thompson.
Reflecting on 12 years of his
life in Germany, Thompson tells us
how he initially lost both his voice,
and almost his personality, too. At
the outset, he didn’t want to learn
German, fighting both the language
and the culture. Theming his tales in
the “Losing” part of the book under chapters such as “Fear”, “Anger”, “Rules”, Thompson describes
the difficulty of learning German
at night school from a teacher who
could deal quite competently with
learning tools but was totally at sea
when it came to dealing with the oft
agonising feelings experienced by
some of her older learners.
Thompson soon began to understand that what he really needed was
an approach to language learning
that would take on this complex task

of language learning in
the same way that children do. They listen and
mimic and eventually
create their own words,
phrases and sentences.
This clearly wasn’t what
was happening at his
night school.
Moving on to “Finding Another”, one of my
favourite chapters, sees
Thompson striking up
an unlikely bond with
an apparent neo-Nazi sympathiser.
Thompson not only discovers that
language is the key to overcoming
prejudice, but he also surprises himself by just how much he can share
with and learn from others by using just very simple language. Now
able to express himself adequately,
Thompson eventually finds himself
able to counsel Germans — in German. In a later chapter, Thompson
realises how the door to understanding German can perhaps be easier
unlocked by pursuing activities not
directly linked to having to understand language — such as learning
yoga.
Losing my Voice and Finding
Another will entertain and motivate
readers who wonder what it’s like —
and are possibly seeking motivation
— to learn a foreign language at a
late stage in their lives. It’s also a plea
for a more sensitive, take-your-time
approach to teaching foreign languages to adults. At the same time,
it fills a wide gap in an English-language market.
Losing my Voice and Finding Another is available as an e-book on
Kobo: https://www.kobo.com/de/en/
ebook/losing-my-voice-finding-another
For free chapter online: http://
nuernbergcounseling.com/my-publications/second-language-acquisition-and-immigrant-experiences/
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Journalist, web manager, blogger, tweeter, voice-over
artist, trainer, teacher-trainer, musician, raconteur and
Melta friend Eamonn Fitzgerald died on 26 August at
the age of 64.
Eamonn — or “Eamondo”, as I fondly called him
— grew up in a rural community in County Limerick
at a time when Ireland was very conservative in its
values. And although Eamonn retained some elements
of that conservatism, he was an extremely modern
person, fascinated by technology and its applications.
After studying law and then journalism in Ireland,
Eamonn found his way to New York and then on to
Munich, where he became a business English trainer,
working in-company.
Eamonn joined Spotlight Verlag in October 1998
to set up the first website for Spotlight magazine. He
was its content manager until 2010, when he became
an independent social media consultant and returned
to teaching.
Eamonn was a technology columnist and author
for Business Spotlight from its first issue in March
2001. His “English 4.0” column explored the connection between technology and industry. And he produced one of his finest pieces of work shortly before
he died, a cover story for Business Spotlight 6/2019
about the trade war and battle for economic supremacy between the US and China.
Eamonn’s interests went far beyond technology
and business, however. He was a lover of, and expert
on, film, food, history, languages, literature, music,
poetry, religion, sport, whisky, wine and much more.
Each year, he re-read his (and my) favourite book, The
Great Gatsby.
Those who knew him will attest to his charm, wit,
kind-heartedness, generosity and willingness to take
the time to discuss any topic under the sun with anyone, even those — or particularly those — who didn’t
share his views. He was described lovingly by his wife,
Ann, as a “prickly contrarian” on his “Rainy Day”
blog (http://www.eamonn.com/). Eamonn was a very
likeable and inspiring contrarian.
Last, but not least, Eamonn was a great friend to
many of us. His passing is an extraordinary loss, both
personally and professionally. Our thoughts are with
his family and, in particular, with his wife.
Ian McMaster
Editor-in-chief, Business Spotlight
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Tribute to Eamonn Fitzgerald
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Melta Events
7 December 2019

Annual Christmas Party:
See the Melta website for details

Spring

Patricia de Griese

Exact date and time TBD

Sponsored by Klett. Details coming soon to the Melta website!

External Events
18 April–21 April 2020

IATEFL Conference in Manchester
The IATEFL International Conference is one of the largest events in the global
English language teaching calendar.

MVHS Events
J581522 / Full-time / December–February
2019
Emma Jones and Amanda Momeni ·
Gasteig · Rosenheimer Str. 5 · M–F 9:00–
18:00 · Breaks on agreement · 02.12.2020
– 28.02.2020 · €1,745 · 12 places

Certificate in English Language Teaching to Speakers of Other Languages (CELTA)

J581504
Amanda Momeni · Gasteig,
Rosenheimerstr. 5 · Saturday 9:30–16:30 ·
25.01.2020 · €65 · 12 places

CELTA Language Awareness Day

CELTA full-time courses are intensive and rewarding. CELTA part-time courses are
suitable for people who have other commitments during the week or live outside of
Munich and therefore do not have time to complete an intensive course. For further
information please visit www.mvhs.de/celta

This one-day course is designed to help participants of the CELTA course by offering
a brief overview of English language and terminology immediately prior to the
CELTA course. The course is strongly recommended for CELTA participants. In special
circumstances and after consultation with the CELTA Course Director, other teachers
of English may be admitted on to this course.

The London office of the British Council and their partner UNICEF have developed the “Vocabulary Challenge”
at www.vocabularychallenge.org. It’s a project that was built to detect levels of English around the globe. Users
who take the challenge (German native speakers) are given a German phrase and asked to fill in an underlined
word in the sentence in English below. For every right answer, the British Council is giving £0.01 to UNICEF, so
respondents are doing it all for a charitable cause.

Non-ELT Events

*We are born to sing“
Looking for enthusiastic singers for our informal singing group.
Plans are to meet once a week or once a fortnight.
We already have a venue in Munich.
Organization is in the early stages.
Keep the sixties, seventies and eighties rockin’.
Awakened your curiosity???
Then get in touch.
Breda Howe (Melta committee member):
bredahowehelmecke@t-online.de
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Munich English Language Teachers Association e.V.
c/o Randy Perry, Montgelasstr. 6, 81679 München

The Munich English Language
Teachers Association (Melta) is a
regional professional association for
all teachers of English working in the
Munich area: teachers at companies,
private schools and the Volkshochschule (VHS), as well as state school
teachers. Established in 1989, Melta
is part of a wider network of English teachers’ organisations throughout Europe and has especially close
ties to the other English Language
Teachers Associations (ELTAs) in
Germany. Melta is also affiliated
with the International Association
of Teachers of English as a Foreign
Language (IATEFL).

Guest speakers and
practical workshops

By attending and taking part in Melta events you can pick up new ideas and re-evaluate your own teaching. There are regular presentations
and lectures in which you can meet
leading people from the EFL/ESL
field. The workshops also give you
a chance to meet other teachers as
well as to contribute your own ideas
about English language teaching and
discuss them. You can question your
own and others’ ideas about language training topics, helping you to
become a better-informed and more
effective trainer in the process. You
will also receive a copy of our newsletter, Melta News, written by members for members, three times a year.
Melta News includes topical articles
on a range of ELT topics, interviews,
and reviews of seminars, books and
videos. There is also a calendar of local and international events in every
issue.

Social events

The Melta calendar also lists social
events, including our summer and
Christmas get-togethers.
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Become a Melta member
Melta provides a forum for:
• Information and experience exchange
• Training and teaching development
• Social contact and support
Melta membership benefi ts include:
• Presentations by leading
EFL/ESL guest speakers
• Practical workshops and
demonstrations
• Our newsletter, Melta News,
twice a year
• Social events
Melta online – www.melta.de
On the MELTA website you’ll find:
• A programme of upcoming
Melta events
• Job offers
• Links to interesting topics
• A list of teachers. All Melta members
are invited to add their name.
• Teaching resources

-us

Whether you’ve just arrived in Munich or have been here some time,
Melta provides a local opportunity
for you to keep your teaching ideas
and skills up-to-date and finely tuned
and to contribute and exchange your
own ideas if you wish. In addition,
you have the chance to meet other
people on both a professional and
a social level. Come along to our
next meeting and find out more. Our
events are listed on www.melta.de.
The annual subscription is only
€35 (€15 for full-time students, €100
for institutional membership) which
includes our newsletter and free entrance to most Melta events. You can
read Melta’s articles of association at
www.melta.de/Articles-of-Association.
For more information, visit our
website at www.melta.de or contact:
Randy Perry, Chair
chair@melta.de

Have you moved?
If so, please let the membership
secretary have your new address.

Please
let us know!
No direct debit? Allow Melta
to set up a direct debit (Einzugsermächtigung) for you and you won’t
have to remember to transfer the
fee yourself at the beginning of
each year. Just contact treasurer@
melta.de and the form will be
emailed to you.
Do you have a direct debit and
have changed banks? If so, please
let the treasurer know! Melta incurs
a penalty of €8 for each refused
direct debit. Please help us to avoid
the hassle of claiming this penalty
fee back from you!

IATEFL discount
Did you know that as a Melta
member you can join IATEFL as a
basic member?
Basic membership costs £21 (less
than half the price of a standard
membership) and entitles you to
receive newsletters and discounts to
IATEFL events at a lower cost than
if you became a full member. If you
would like to take advantage of this
offer, please send an email to the
membership secretary, and ask for
a copy of IATEFL’s basic membership
form. The completed form and
payment should be sent directly to
IATEFL.

Go for it! Now complete
from Starter to B2!
Go for it!, the modern English course for adults, uses the latest
findings in educational neuroscience for lessons with fun and ease:
▶

Motivate your learners
- Interesting, enjoyable reading texts
- Countless opportunities for personalisation
- Lively, creative activities

▶

Interactive placement test
- Place participants in the correct course
- Available online and as a PDF

▶

Learn any time and anywhere
- With the free augmented reality app, you and
your course participants can access all the audio
and video files on mobile devices!
- Additional online exercises tailored to each unit

New!

With
AUGMENTED
REALITY APP!

Free online material at
www.hueber.de/go-for-it
NEW!

Go for it! B2
Kursbuch + Arbeitsbuch mit 2 Audio-CDs
232 Seiten
€ 21,50 •
ISBN 978-3-19-042940-0

Erscheint im März 2020

© Getty Images/E+/FG Trade

Teacher’s Notes – Lehrerhandbuch
Ca. 112 Seiten
€ 12,–
ISBN 978-3-19-052940-7

Hueber Verlag
Baubergerstr. 30
80992 München
Deutschland

Tel.: +49 (0) 89 9602-9603
Fax: +49 (0) 89 9602-286
E-Mail: kundenservice@hueber.de
www.hueber.de

FEBRUARY

27–29 FEBRUARY 2020

What if every teacher
around the world could
attend the same event?
Well, you can! In 2020, take your teaching
to the next level at the 2nd Oxford English
Language Teaching Online Conference.
Join us for a series of webinars delivered
by leading ELT experts.

CONFERENCE HIGHLIGHTS
Global Skills
Learn to teach the essential
skills that students need to
succeed in our fast-changing
modern world.

Assessment
Discover tips to plan and
deliver feedback effectively, so
you can support your learners
on their learning journey.

Vocabulary

 Connect with experts and share
your thoughts with colleagues around
the world

Develop your vocabulary
teaching to support your
students with learning the most
important words in English.

 Join any of the sessions and receive a
certificate of attendance and exclusive
ELTOC resource pack

Digital

 Take a moment for you, take a break
and try out our wellbeing tips

Optimise digital tools like
video, mobiles and AR/VR
in your classroom and teach
English with technology.

http://www.oup.com/elt/eltoc

